
Configurazione dell'aggiornamento dell'immagine 
software ASA 9.X con ASDM o CLI
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Introduzione

Questo documento descrive come aggiornare un'immagine software su accessori Cisco ASA 5500 
con Cisco Adaptive Security Device Manager.

Prerequisiti

Requisiti

Nessun requisito specifico previsto per questo documento.

Componenti usati

Le informazioni fornite in questo documento si basano sulle seguenti versioni software e 
hardware:

Cisco ASA 5500 e ASA 5500-X 9.1(2) e versioni successive•

Cisco ASDM 7.1 e versioni successive•



Le informazioni discusse in questo documento fanno riferimento a dispositivi usati in uno specifico 
ambiente di emulazione. Su tutti i dispositivi menzionati nel documento la configurazione è stata 
ripristinata ai valori predefiniti. Se la rete è operativa, valutare attentamente eventuali 
conseguenze derivanti dall'uso dei comandi.

Prodotti correlati

Questa configurazione può essere utilizzata anche con il software dell'appliance di sicurezza 
Cisco ASA serie 5500-X versione 9.x.

Convenzioni

Fare riferimento a Cisco Technical Tips Conventions per ulteriori informazioni sulle convenzioni 
dei documenti.

Download Software

Per scaricare la versione richiesta delle immagini del software ASA e delle immagini del software 
ASDM, usare questi collegamenti:

Download della versione del software Cisco ASA (solo utenti registrati)•

Download della versione del software Cisco ASDM (solo utenti registrati)•

Nota: per scaricare il software dal sito Cisco.com sono necessarie credenziali utente Cisco 
valide.

Compatibilità tra ASA e ASDM

Il collegamento mostrato viene aggiornato con la compatibilità e la versione ASDM consigliata da 
Cisco per ciascuna versione dell'appliance ASA.

Compatibilità ASA e ASDM

Percorso di aggiornamento ASA

Il collegamento mostrato fornisce il percorso di aggiornamento dell'appliance ASA. Alcune versioni 
richiedono un aggiornamento temporaneo prima di poter eseguire l'aggiornamento alla versione 
più recente.

Percorso di aggiornamento ASA

Aggiornamento di un'immagine software ASA con ASDM 7.x

Completare questa procedura per aggiornare un'immagine software sull'appliance ASA 5500 con 

https://www.cisco.com/c/it_it/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://www.cisco.com/c/it_it/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://software.cisco.com/download/home/278875415
https://software.cisco.com/download/home/279513399/type/280775064/release/7.17.1.155
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html#pgfId-121785
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html#id_58680


ASDM.

1. Quando l'appliance ASA è in modalità contesto singolo, selezionare Tools > Upgrade Software from Local 

Computer... dalla finestra Home di ASDM.

 

Quando ASA viene eseguito in modalità a contesto multiplo, Upgrade Software from Local Computer sotto il 
Tools è disponibile solo dal contesto di sistema.

 
2. Selezionare ASA come tipo di immagine da caricare dall'elenco a discesa.

 



 
3. Fare clic su Browse Local Files... o digitare il percorso nel campo Local File Path per specificare la 
posizione dell'immagine software sul PC. 
 
4. Fare clic su Sfoglia Flash.... 
 
5. Viene visualizzata una finestra di dialogo Sfoglia Flash, con il nome del file immesso 
automaticamente. Se il nome del file non viene visualizzato, immetterlo manualmente nel campo 
File Name campo. Fare clic su OK al termine. 
 

 
 
6. Una volta specificati i nomi dei file locali e remoti, fare clic su Upload Image.

 



 
 
7. Viene visualizzata una finestra di stato mentre ASDM scrive l'immagine sul flash. Al termine, 
viene visualizzata una finestra di informazioni che indica che il caricamento è riuscito e chiede se 
l'immagine deve essere impostata come immagine d'avvio. Seleziona Yes.



Fare clic su OK nella finestra di dialogo Informazioni, quindi fare clic su Close nella finestra di dialogo 
Carica immagine da PC locale. 

8. Scegliere Tools > System Reload dalla finestra Home per ricaricare il dispositivo.

 
 

Viene visualizzata una nuova finestra che verifica i dettagli del ricaricamento. Seleziona Save the 

running configuration at the time of reload quindi scegliere l'ora da ricaricare. Le scelte temporali includono:

Riavviare il dispositivo immediatamente.•
Ritardo di: specificare tra quanti minuti o ore si desidera ricaricare il dispositivo.•
Schedule at: consente di specificare la data e l'ora in cui ricaricare il dispositivo.•

 
Inoltre, specificare se il dispositivo deve forzare un ricaricamento immediato quando un 
ricaricamento pianificato non riesce. Assegno On Reload failure, force an immediate reload after e quindi 
specificare un tempo di attesa massimo. Si tratta del tempo di attesa dell'appliance di sicurezza 
per la notifica degli altri sottosistemi prima di un arresto o di un riavvio. Trascorso questo periodo 
di tempo, si verifica un rapido (forzato) arresto/riavvio. Fare clic su Schedule Reload.

 



 
Una volta eseguito il ricaricamento, Reload Status viene visualizzata una finestra per indicare che è in 
corso un ricaricamento. È inoltre disponibile un'opzione per uscire da ASDM. 
 

Nota: riavviare ASDM dopo il riavvio dell'ASA.

 



Aggiornare l'immagine ASDM utilizzando ASDM 7.x.

Completare questa procedura per aggiornare l'immagine software sull'appliance ASA 5500 con 
quella di ASDM.

1. Selezionare Tools > Upgrade Software from Local Computer... dal Home dell'ASDM.

 



 
 
2. Selezionare ASDM come tipo di immagine da caricare dall'elenco a discesa.

 
3. Fare clic su Browse Local Files...  o digitare il percorso nel campo Local File Path per specificare la 
posizione dell'immagine software sul PC.

Fare clic su Browse Flash....

A Browse Flash viene visualizzata la finestra di dialogo con il nome del file immesso automaticamente. 
Se il nome del file non viene visualizzato, immetterlo manualmente nel campo File Name campo. 
Fare clic su  OK al termine.



 
4. Fare clic su OK quando l'immagine viene aggiornata con la nuova immagine.

 
5. Selezionare File > Save Running Configuration to Flash dal Home dell'ASDM.

 



 
Uscire da ASDM e accedere nuovamente per gestire l'ASA con l'immagine ASDM aggiornata.

Aggiornare ASA e ASDM in base a un'immagine Scarica 
Direttamente da CCO

 
Completare questa procedura per aggiornare un'immagine ASA e ASDM direttamente da CCO. 
 
1. Selezionare Tools > Check for ASA/ASDM Updates... dal Home dell'ASDM.

 
2. Quando viene visualizzato il prompt di nome utente e password, fornire le credenziali 
Cisco.com e fare clic su Login.



 
 
3. Il Cisco.com Upgrade Wizard viene visualizzata una finestra di dialogo. Nella scheda Overview , fare clic 
su Next. 
 



 
 
4. Nell'ambito Select Software selezionare il software da aggiornare. Se si desidera aggiornare sia 
ASA che ASDM, selezionare entrambe le opzioni. 
 



 
5. Nell'elenco a discesa Versione ASA, selezionare la versione a cui deve essere eseguito 
l'aggiornamento dell'ASA.



 
6. Nell'elenco a discesa Versione ASDM, selezionare la versione a cui deve essere eseguito 
l'aggiornamento di ASDM. Fare clic su Next quando sono state selezionate le versioni appropriate.



 
7. Nell'ambito Review Changes , rivedere le modifiche e fare clic su Next.



 
8. L'installazione delle immagini ha inizio e lo stato complessivo può essere visto come mostrato. 
Al termine, fare clic su Finish. 
Nella scheda Results sezione, controllare la Save configuration and reload device now opzione. Fare clic su Finish.



 
9. Il Reload Status durante il riavvio del dispositivo.



 
10. Fare clic Exit ASDM ed eseguire nuovamente l'accesso quando il dispositivo viene riacceso dopo 
il riavvio.

Uso di CLI per aggiornare un'immagine software e un'immagine 
ASDM

Per aggiornare o effettuare il downgrade di un'immagine software e di un'immagine ASDM per 
un'appliance ASA, è necessario un server TFTP. Per ulteriori informazioni sulla selezione del 
server TFTP, fare riferimento a Selezione e uso del server TFTP.

OSPF (Open Shortest Path First) copy tftp flash consente il download di un'immagine software nella 
memoria flash del firewall da parte del protocollo TFTP. Utilizzare il copy tftp flash con qualsiasi 
modello di appliance di sicurezza. L'immagine scaricata può ora essere utilizzata al successivo 
riavvio modificando la variabile del sistema di avvio in modo da puntare a questa immagine.

Questo è l'output del copy tftp flash comando:

 

https://www.cisco.com/c/it_it/support/docs/routers/10000-series-routers/48700-tftp-server.html


copy tftp[:[[//location] [/tftp_pathname]]] [[flash/disk0][:[image | asdm]]]

 

Per la modalità a contesto multiplo, eseguire questi passaggi nello spazio di esecuzione del 
sistema.

Nota: per l'appliance ASA, la parola chiave disk0 sostituisce la memoria flash nell'unità copy

Se il comando viene usato senza i parametri opzionali location o pathname, la posizione e il nome 
del file vengono ottenuti dall'utente in modo interattivo tramite una serie di domande simili a quelle 
presentate dal software Cisco IOS®. Se vengono immessi solo due punti, i parametri vengono 
ricavati dal tftp-server impostazioni del comando. Se vengono forniti altri parametri facoltativi, questi 
valori vengono utilizzati al posto dei parametri associati tftp-server impostazione del comando. Se 
vengono specificati dei parametri facoltativi, ad esempio i due punti e qualsiasi elemento 
successivo, il comando viene eseguito senza richiedere l'input dell'utente.

La posizione può essere un indirizzo IP o un nome che viene risolto in un indirizzo IP dal 
meccanismo di risoluzione dei nomi dell'accessorio di protezione, attualmente statico e mappato 
dal name e names comandi. L'accessorio di sicurezza deve essere in grado di raggiungere questa 
posizione utilizzando le informazioni della relativa tabella di routing. Queste informazioni sono 
determinate dal IP address,OSPF (Open Shortest Path First) routeo RIP comandi. Dipende dalla 
configurazione.

Il percorso può includere qualsiasi nome di directory oltre all'ultimo componente effettivo del 
percorso del file sul server. Il percorso non può contenere spazi. Se il nome di una directory 
contiene spazi, impostarlo sulla directory nel server TFTP anziché nella copy tftp flash E se il server 
TFTP è configurato in modo da puntare a una directory del sistema da cui si scarica l'immagine, 
utilizzare solo l'indirizzo IP del sistema e il nome file dell'immagine. Il server TFTP riceve il 
comando e determina il percorso effettivo dei file dalle informazioni della directory radice. Il server 
scarica quindi l'immagine TFTP sull'appliance di sicurezza.

Questi comandi sono necessari per aggiornare l'immagine software e l'immagine ASDM e 
renderla un'immagine di avvio al successivo caricamento.

 
<#root>

ASA

#copy tftp [[flash:/disk0:][software image name/asdm image name]]

 

!--- Command to set an image as bootup or specify the 

!--- ASDM image file.

 
 
ASA(config)

#boot system [flash:/disk0:]/[software image name]



 

!--- Save active configuration to the Flash.

 
ASA

#write memory

 

!--- Reboot the security appliance and load 

!--- with the new boot image as per the configuration file.

 
ASA

#reload 

 

Esempio:

 
<#root>

ASA-5512# copy tftp: disk0: 
 
Address or name of remote host []? 172.16.31.1 
Source filename []? asa916-smp-k8.bin 
Destination filename [asa916-smp-k8.bin]? 
Accessing tftp://172.16.31.1/asa916-smp-k8.bin...!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
Writing file disk0:/asa916-smp-k8.bin... 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
38043648 bytes copied in 32.290 secs (1188864 bytes/sec) 
 
ASA-5512# sh disk0 
--#--  --length--  -----date/time------  path 
 

 191  38191104    Nov 21 2014 21:07:48  asa912-smp-k8.bin 

  192  17906032    Apr 08 2015 22:33:44  asdm-713.bin 

  193  26350916    Apr 09 2015 06:28:20  asdm-741.bin 

  194  38043648    May 10 2015 02:14:06  asa916-smp-k8.bin 

 

4118732800 bytes total (3556712448 bytes free) 
 
 

!--- Command to set "asa916-smp-k8.bin" as the boot image.

 
ASA-5512(config)

# boot system disk0:/asa916-smp-k8.bin

 

!--- Command to set "asdm-741.bin" as the ASDM image.



 
ASA-5512(config)

# asdm image disk0:/asdm-741.bin

ASA-5512

# write memory

ASA-5512

# reload 

 

Nota: quando si cerca di aggiornare l'immagine sull'appliance ASA da un server FTP, usare 
il comando copy ftp flash Questo comando consente di specificare parametri quali l'indirizzo IP 
remoto e il nome del file di origine. Questa procedura è simile al TFTP. Tuttavia, un limite è 
che non è possibile modificare l'interfaccia IP/sorgente remota (come avviene con il 
protocollo TFTP). In modalità TFTP, le opzioni specificate con il tftp-server può essere estratto 
ed eseguito. Ma con l'FTP, non esiste questa opzione. Per impostazione predefinita, 
l'interfaccia di origine è sempre esterna e non può essere modificata. In altre parole, il server 
FTP è raggiungibile dall'interfaccia esterna.

Verifica

Utilizzare questa sezione per verificare che l'aggiornamento del software sia riuscito.

Cisco CLI Analyzer (solo utenti registrati) supporta alcuni show comandi. Usare Cisco CLI Analyzer 
per visualizzare un'analisi del show output del comando.

Dopo il riavvio dell'ASA e il nuovo accesso ad ASDM, verificare la versione dell'immagine in 
esecuzione sul dispositivo. Vedere la General sulla scheda Home per queste informazioni.

I seguenti comandi CLI vengono utilizzati per verificare l'aggiornamento:

https://cway.cisco.com/cli
http://tools.cisco.com/RPF/register/register.do


Show version: restituisce l'immagine corrente con cui viene avviata l'appliance ASA.1. 
Show bootvar — mostra la priorità dell'immagine da usare dopo il riavvio.2. 
Show asdmimage: visualizza l'immagine ASDM corrente utilizzata dall'appliance ASA.3. 

Risoluzione dei problemi

Non sono attualmente disponibili informazioni specifiche per risolvere i problemi relativi a questa 
configurazione.

Informazioni correlate

Note sulla release•
Nuove funzionalità di Cisco ASA per versione•
Compatibilità Cisco ASA•
Pianificazione dell'aggiornamento•
Aggiornare una configurazione di failover attivo/standby•

https://www.cisco.com/c/it_it/support/security/asa-5500-series-next-generation-firewalls/products-release-notes-list.html
/content/en/us/td/docs/security/asa/roadmap/asa_new_features.html
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/asa-appliance-asav.html#concept_xxv_yvn_kkb


Informazioni su questa traduzione
Cisco ha tradotto questo documento utilizzando una combinazione di tecnologie automatiche
e umane per offrire ai nostri utenti in tutto il mondo contenuti di supporto nella propria lingua.
Si noti che anche la migliore traduzione automatica non sarà mai accurata come quella fornita
da un traduttore professionista. Cisco Systems, Inc. non si assume alcuna responsabilità per
l&rsquo;accuratezza di queste traduzioni e consiglia di consultare sempre il documento
originale in inglese (disponibile al link fornito).


